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Section 1: Getting Started Soeee oo

THANKYOU...

...for choosing an LX610e Color Label Printer. The LX610e Printer will print razor-sharp text and barcodes, vibrant colors, and even
stunning photo-realistic photographs directly onto rolls of labels, card stock and a variety of other approved media. AND with the
built in digital die cutter you can cut and create your labels in any size or shape you choose.

This User’s Manual is your complete step-by-step guide to quickly and easily setting up and printing with your new Color Label
Printer!

1A Choosing a Good Location

® Placethe printer on aflat surface in alocation with adequate air circulation to prevent internal heat buildup.

® Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sun
light, excessive dust, mechanical vibration or shock.

* Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving
the printer to avoid the possibility of binding or jamming of the label stock.

e Allow for 6” of clearance behind the printer to accommodate loop creation during cutting operations. The
area directly behind the printer must also not be obstructed by USB or power cables connected to the
printer.

e Allow for adequate overhead clearance for opening the top cover to allow easy access to the labels tock
and ink cartridge. The printer will require 7 inches (17.78 cm) of additional space on the top side to completely
open the cover (Total = 16.5"0r 41.91 cm).
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1B Unpacking and Inspection

While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping.
Make sure that all supplied accessories are included with your unit. The following items are included in the
supply box:

-_—

Power Adapter and Cord

6’ USB Cable (If other USB cable is used, it must be 6’ (2 M) or less)

Color Dye Ink Cartridge Part Number 53496 (Pigment is also available — Part Number: 53491)
Die Cutting Knife Holder with knife preinstalled

Label roll holders (Assembly required - section 1C)

Large Roll Hub

Small Roll Hub

T8 Allen Key and two screws

O © N o U M W N

Printed documentation
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1C Installing the Roll Holders

Some light assembly is required before operating the printer.Follow these instructions to install the roll
holders.

1. Set the printer on its front so the bottom is facing you

2. Install the movable label roll holder by attaching the hooked end on the rail. The bottom of
the holder will fit in the notch on the printer.

Movable Roll Holder

Movable Roll Holder

Rail

Tab

| 7



3.

4.

Slide the Roll Holder to the far right.

Install the roll guide by attaching the hookedend on the rail. The bottom of the holder will fit in the
notch on the printer. Roll Guide

Roll Guide
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Stop

Slide the Roll Holder to the far right.

Locate the remaining roll holder with the protruding wire. Connect the wire to the port on the
printer.Tuck the wire inside the cavity.

Push the wire into
the cavity as you
move the holder
closer to the

" notch

Wire \% Notch
F-'"""--.
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7.  Snap the holder in place so the two screw holes line up with the holes on the printer.

8. Install the T8 screws using the INCLUDED Allen key or a Torx T8 screwdriver.

9. Rotate the printer back on its feet.
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1D Identifying the Parts

These illustration shows the printer from various angles so all important parts can be identified.

PR[MEM Control Panel

Fower Ink

oo |

Front Cover

The Power LED indicates that the printer is on and ready to receive print jobs.

The Ink LED will illuminate when a cartridge has 10% or less of its ink remaining.

The Pause Button is pressed to pause a job to allow for loading of label stock and ink cartridges. The print-
er pauses after the printing of the current label has finished.

The Feed Button is pressed in order to load label stock if the printer does not automatically detect the
stock. When stock is loaded each press of the button will cause one label or a few inches to be fed through
the printer.

The Unload Button is pressed to unload label stock after you receive an End of Roll message in PrintHub.
The printer will reverse the label stock through the feed area.

|11



Interior

Print Carrier

: : Die Cutter Upper Guide
Die Cutting PP Ribbon Cable

Carriage Ribbon Cable Shaft

Print Carrier

4

\\\\\\

{\\\\-‘f
L) 0
PN L

\ \ Wear Strip
Knife Collar Die Cutting Lower Guide Pre die-cut Die Cutting
Handle Knife Shaft rollers Pinch Rollers
Cutter Wheel
Mechanism
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Back
Gap Sensor Movable
Infeed Area Adjustment Throat Guide Power Switch

/

Power
Movable Roll
Fixed Roller Fixed Guide Holder
Holder w/
Chip Reader
000000 60
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Section 2: Media, Cartridges and Knives

2A Label and Roll Specifications

Pre Die-Cut Labels. A wide variety of pre die-cut label stock can be used in the printer. Refer to the
specifications and settings in the following sections before ordering custom stock from Primera or any
stock from another company.

Digital Die-Cut Labels. If you are using the printer to digitally die-cut your own shapes and sizes only
DTM/Primera or Primera ASIA label stock can be used.

Important! Test all custom made label stock with the intended printer before ordering large quantities!
Primera will only assume responsibility for custom label stock ordered from DTM/Primera or Primera ASIA.

Label Sensing Methods r : Y
! Label Width
]! Label Width I
1
1
: Gap Sensor Adjustment Range
Method 1: Label - ~ — f:lfellgsetween
Gap Sensing - N~
1
1
1
1
1
1
1
1
1
Method 2: Through-Hole -:E::-_ ’
Sensing —(  [«— Width of Opening ) 1
| | \ Distance from / | | Label Height
edge of Media
to edge of Label
Method 3: Reflective/Black \—);
: -
Mark Sensing
(Black Mark must be printed
on back side of label stock) Black Mark
Width
. J

Note: See table below for Max and Min values in inches and mm.
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Label width 127mm (5") 13mm (0.5")
Liner/media width 130.177mm (5.125") 50.8mm (2")
Label height/length 305mm (12") 13mm (0.5")
Gap between labels 253mm (10”) 2.5mm (0.10")
Width of through-hole 12.65mm (0.5”) 6.325mm (0.25")
Gap Sensor Adjustment 52mm (2.05") 10.16mm (0.40")
Range (from left edge)
Reflective/Black Mark Width* N/A 2.54mm (0.1")
Max Outer Diameter (OD) 152.4mm(6.0") N/A
Inner Core Diameter (ID) 76.2mm (3.0”) 76.2mm (3.0”)
Recommended Total Thickness 10 mil (.0010")
(Liner + Label)**
Distance from edge of media to Printer assumes 2mm (1/16") gap. However, this is adjustable
edge of label via the left margin offset.

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the labels. The
end of the mark should correspond with the beginning of the label.
**This is the recommended maximum. There are two factors that determine whether the printer will accept
any particular stock thickness.

1. The ability for the printer to pull the paper through the print area.

2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact that the
printer must read through the backing in die-cut mode will limit the thickness much more than the
printer’s ability to pull the paper through the print area. However, if you adjust opacity level of the liner
enough to allow the label to be seen by the stock sensor, the thickness will only be limited by the printer’s
ability to pull it through the printer area. For these reasons the weight or thickness of the liner is a variable
that cannot easily be defined. Primera recommends and uses 40# liner with all Pre Die-Cut label stock.

It is important to test all label stock with the intended printer before ordering large quantities!
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Roll specifications:

Label Side Out\

Roll O.D. Label Stock

6"
(Max)

_____E.é____

Core I.D.
Core O.D.

Note on Label Orientation: If you are using an applicator to apply your labels, be sure to order label stock with the correct
orientation for your applicator. For example, most applicators will apply the side of the label first, so you will want to print the
labels sideways.
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2B Installing Digital Die-Cutting Label Stock

1. Move the roll holder to the preset position for on demand digital die-cutting
(3rd mark from the left — 1.25")

Move to third
mark from Left

,,,,,,,,,,,,,,

——————————————

I
o
i
1 [
‘ ) {

AT N

2. Install the Blue Hub on the open side of the digital die-cutting media.

Note: The green hub is not needed for
digital die-cutting and can be stored in
the notch on the movable holder.

\
™,
\'.
s \ ——— |
|
- /
Digital Die Cutting —
Media comes with
black hub with green Blue Hub
e 000000 00
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3. Settherollin place so that the blue pin sits in the notch on the roll holder.

Blue Pin

4. Make sure the green chip holder fits in the corresponding green slot on the roll holder.

Green Chip
Holder
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5. Before feeding the stock you must plug in power and switch on the printer.

Power Cable

6. Guide the leading edge of the roll into the feed area. Move the blue guide to the far side.

Blue Guide

7. Push until the printer detects the stock, grabs it and pulls it through the printer.

119



2C Installing Pre Die-Cut Label Stock

1. Move the roll holder to the approximate position which matches the width of the stock you are
installing. You can always fine tune this later.

2. Install the Green Hub on the right side of the pre die-cut media.

Green Hub Blank Chip Holder Smart Chip Black Hub

Die Cuts

Continuous Media ><H —
Pre Die-Cut Roll Digital Die-Cut Roll
(User must install Green Hub) (Hub/Chip comes preinstalled)
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3. Install the Blue Hub on the left side of the digital die cutting media.

Pre Die-Cut Media

4, Settherollin place so that the blue pin sits in the notch on the roll holder.

Blue Pin
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5. Make sure the green blank chip holder fits in the corresponding green slot on the roll holder.

Green Chip
Holder

Power Cable

22|
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6. Guide the leading edge of the roll into the feed area. Move the blue guide so that it touches the

label stock.
Gap sensor should
intersect the gap
between labels
Blue Guide

T

Note: the positon of the label sensor. Slide

the sensor position indicator so that it Gap Sensor Position
Indicator from right

intersects with the gaps between your labels.
gap 4 edge of media

For most label stock you will not need to
move this.

7. Push until the printer detects the stock, grabs it and pulls it through the printer.
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2D Replacing the Digital Die Cutting Knife holder

Install the included die cutting knife shown here.
1. Open the Cover

2. Pull out on the blue handle to loosen the knife collar.

24 |
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Install the knife holder.

Push on the knife so it goes all the way
down before pushing the collar in.

Push the collar to tighten the knife holder
and allow it to cut.
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2E Replacing the Cutting Knife

When a knife is dull it will no longer cut through the label at maximum pressure. You will start to see ragged
cuts or cuts that do not cut all the way through the label material. You can attempt to increase the pressure
but you'll probably need to replace the knife.

If a knife cuts through the liner and contacts the wear strip it may break the tip of the knife. This can be seen
under 10x magnification using a loupe or magnifying glass. If the tip is broken the knife must be replaced.

If your knife needs replacement, follow this procedure:

1. Remove the knife holder from the carrier using the instructions from

section 2D.

Knife Holder
2. Rotate the cap of the knife holder counter clockwise.

3. Remove the knife from the holder. You can tap the holder on a hard \

surface to free the knife from the holder.

4. Locate a new knife. Remove the molded plastic cover from the knife. The plastic cap covers
the cutting end of the knife. However, both sides are sharp! The cutting end has an angled carbide
tip. The top end comes to a point so it can be easily centered in the receiving divot on the knife

/

Centering

holder cap.

5. Insert the cutting end into the knife holder.
Point
6. Using the knife holder cover center the back end of the knife in the
holder. You may need to screw down the cover and reverse it sev

eral times until the knife has been centered. Do not force the cap
on the holder. The carbide tip will brea

\Carbide Tip

Replacement Cutter Knife 5 pack Part Number: 074332 (Cutting End)
Replacement Knife Holder Part Number: 074548
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2F Replacing Ink Cartridges
You can replace cartridges at any time or wait for the Low Ink Warning to prompt you to replace
cartridges. You will receive low ink warnings at 10% and 0%. Press the Load/Feed button to continue

printing after you receive this warning.

To change a cartridge, follow this procedure:
1. Open the front cover. That cartridge will automatically move to the right side if it is not
already there.

2. Press or pinch the tab on the front of the cartridge holder.

3.
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4. Locate a new cartridge and remove it from its packaging. Remove the foil outer package and
the tape covering the nozzles.

Remove Tape

5. Place the new cartridge into the empty carriage. Note: When installing the cartridge, tilt the
cartridge at a slight backward angle of approximately 30 degrees.

Side View

6. Make sure the cartridge is pushed back far enough so the ridge on the cartridge is behind
the spring-loaded pusher on the lid. Push down on the cartridge. Close the lid on the cartridge by

lightly pressing down from the top until you hear a click.

PUSH DOWN

28|
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2G Adjusting the Gap Sensor Position (Pre Die-Cut Labels Only)

If you are using label stock other than standard square / rectangular die-cut labels such as circular die-cut
labels or through-hole stock use the instructions below to adjust the position of the label stock gap sensor.
The sensor can be adjusted using the slide bar on the back of the printer. Below the slide bar is a
measurement which represents the distance between the edge of the label stock and the sensor. Measure
the distance from the edge of the label stock to the correct position on the stock. Set the sensor so the side
of the slide bar lines up to this measurement. See dashed line in the illustration below.

Important Note: You must adjust the stock
sensor before loading nonstandard label
stock.

Circular Labels

If you are using Circular Labels you must adjust the stock sensor to correspond with the very top of the
label where the circles are closest together. If the sensor is too far to the right or the left the printer will still
sense the label but the image may be offset downward because the printer will start printing at the wrong
position. If you are using stock that has multiple labels across, make sure the sensor corresponds to a place
on the stock that has a label and not a vertical gap Important Note: You must adjust the stock sensor before
loading nonstandard label stock.31The sensor can only be moved a maximum of 2 inches from the left side
of the printable area. This means that the maximum diameter circular label that can be printed is 4 inches.
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For circular labels larger than 4 inches in diameter, you must have a black mark printed on the back of the
label stock.This means that you must change the Stock Sensor Mode to Reflective. The printer will now look
for the black mark representing the beginning of the next label instead of the die-cut. For moreinformation
on changing the Stock Sensor Mode see section 3C.
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Section 3: Primera PrintHub Sopeee ce

Primera PrintHub is used to interact with the printer for gathering ink levels, maintenance, alignment, cost
calculation and several other functions. You can use it to manage these functions on multiple LX610e
printers and other Primera label printer models. PrintHub automatically installs with your printer driver and
can be accessed through the printer driver preferences or as a program on your Windows start menu.

1. Connect the printer via USB and turn on the power. The PrintHub accesses most of the information
it uses from the printer itself so the printer must be turned on and communicating for the program
to be useful.

2. Goto Start - Programs - Primera Technology - Primera PrintHub.

i)

Cotor Label 610 - Igle 5
Cofor Label 830 - : % High lacs Papr
. Quece | Prnt Mligrmans | Lt faed | Priver Semegs

abe - S0%%
Cancel higme Tirne Suberatied 13 "
[ oo |s| @ [ [H)
Fcs
T
St boh Masre ekl Prind Codt Provhs o Cartricige Prints Ae
@ E St b H gaiiT | 4T aif
3 T O N & S G
Mign  (hangs  Clean

— ?’F {F
595 r Gt .:‘
ik Grnly 3 g o,

| m HOTE Perd ot bt § label for 3 mong scoursts cont arimabe J -‘
a. Adjust alignment, sensor mode, output mode and advanced settings.

b. If you have multiple Primera printers connected, they will be listed here.

¢.  Pastjobs will show the last 5 jobs along with cost information. Click the document icon to
view a cost report.

d. Application Settings

e.  Print Queue shows the currently printing job.

f.  Order Link

g. Frequent Activities

h.  Current Ink Levels (Ink is displayed in 10% increments. Example 100% to 90% to 80% etc.)

Digital Die Cutting Media Status and Remaining Amount (If installed)
000000 00
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3A Adjusting Knife Pressure and Stretch Factor

Knife Pressure and Stretch Factor settings can be found in Primera Print Hub on the Printer Settings Tab for
the LX610e Click the Advanced Settings button to view these settings.

] Promese PrrtHub
LXE1D
3 ’ Color Label 610 - |dle | Cigital Din-Cot Rbedis
Coler Lusel £3) b 5%
Cropue | Prin Aligrma Label P | Pitner Samingd
Trg
Ereer Cohar Label 810 (1500
Firmwing 137 TUA019 4] 11,06 1
Senal Humiser y
Eolteare Versesn 1400 0%
$ H *
Mign  Chaege  Clean

L o
(] indiree Cinky ’ $ \x

Pressure affects how deep into the media the knife will

[ At Settngs tor oo Lokl 10 X
cut. Ideally you want to cut deep enough to cut through
General Settings
the label layer on the top but not so deep that you cut bt B I
through the backing paper. When you cut through the e i
backing paper your label will not peel cleaning off the Caridgs Santings
backing paper. You will also score the wear strip under S i T - E
Fages bebween Mentensnce Wipes |10
the cutting knife. It will then need to be replaced more | suppress Aignmens
often. Stock Feed Settings
Fodl Feed Speed 01 nfsec) &0 B
By default, the cutter is calibrated towork with High feect Spees (1 ivsee) « B
. . Prind Speed LT indsech 23
Gloss Paper Media. However, other media types R = E
will need more or less cut pressureto cut properly. Vartical Print e (L) N
XY Cutter Settings
Each roll of media will have a recommended value Riite Presoure 0 E
Erofe Sireich Fachor 0

to add or subtract from the default baseline value

usedfor High Gloss media. Thedefault value is zero. For
Magneticmedia,stretch factor will need to be adjusted
to compensate for the thicker material and different feed speed.
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Adjusting Knife Pressure over time.

Eventually, the knife blade will begin to wear and require more cut pressure to cut at the same depth as
when it was brand new and sharper. Therefore, you may need to add cut pressure when cutting any media
even the High Gloss Paper.

To determine if cut pressure needs to be increased or decreased, follow these steps.

—_

1. Print and Cut 1 copy and then attempt to peel the label from the liner.

2. Check for tear. If the label tears when you remove it, you will need to increase the cut pressure.
Increase pressure in small increments to avoid over compensating and cutting through the liner.

3. Checkthe liner. Once you peel up the label, check the liner. If it has been cut through, decrease
pressure.

4. Continue increasing or decreasing pressure until the label no longer tears when removed or
the liner is not cut through.
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3B Using the Cost Estimator

The cost estimator is found under the queue section on the first tab of the PrintHub. The last five job costs
are stored in the list. Each job will show the cost per label based on the cost per cartridge entered below

the list. Enter the actual cost of the cartridge you paid. Prints remaining on the currently installed cartridge
and total prints on new cartridge are both displayed.
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B[ Tetinn | & 0428 |4 ng
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2 Prnt lobRapert

b bawme

Test1 et
Curmency To L
52 U85 Dol
Coartridgs Cext

e

Sve

Ceat hesert lor Teit i stw
Lhirg Cartridge cost: 57695

Etimated Ink Coct pes Print $0.71%

Fas Primt Datalh
Eain g rinn
Thoe e it

Hartedipr Py wedaspm pue Frict
Join Decads
Frvt

Tiwe Enpied
Provts, pey il Cotredie

Prrsers Technology, s Al laght Redesved

{CRENY
£ RN e

LETTLY

&
0 et sl 40 Sedords

=

34|



DIM

000000 00
print

3C Set the Gap Sensor Mode (Pre Die-Cut Labels Only)

The stock sensor mode refers to the method the printer will use to detect the print starting position for
each label. To adjust the stock sensor mode, open the PrintHub. In most cases you will NOT need to change
this setting. By default, it is set to sense standard Pre die-cut labels. It is only necessary to change this set-
ting if you are using clear labels or any label with a black sensing mark on the back. When you install Digital
Die-Cutting Label Stock this setting will automatically be set for you.

1. Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored in the
printer’s internal memory so you will not be able to access it unless the printer is
turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.
3. (lick on the Label Feed (3rd tab from left).

4. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the
stock you intend to install.

5. Load the label stock after you have set the sensor mode

[ rirmera PrintHut - o =

LEE™D

Color Lkl B o

Al (g Cheaws
D not present Present afer no ity -

L~
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There are three sensor modes:

Die-Cut (Default). If you are using standard die-cut labels that look similar to the graphic, use this setting
regardless of the size of the label. Also, use this setting for Through-hole label material where a hole is
punched through each label or a notch is cut in the side.

Reflective. Use Reflective for label material where a black pre-printed line (black mark) on the back of the
label stock indicates the break between labels. Black marks are required on clear label stock rolls, or label
where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped
labels, circles larger than 4 inches or on any stock where the print starting position cannot be sensed using
the label itself.

Continuous. (Sensor off) If you have continuous stock with no die-cut, reflective mark or holes, set the
sensor type to Continuous. This will turn off the stock sensor. In this mode there is no way to set the print
starting position. The printer will simply start printing the first label and print each subsequent label
immediately after that previous one. To produce a gap between prints simply add the desired amount of
white space to the end of the label being printed. The printer will automatically switch to this setting when
Digital Die Cutting Label Stock is installed.

Important Note: You must also set the Stock Sensor Position (Section 2G)
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3D Set the Present/Cut Mode

Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they

are cut after printing. To adjust the Present/Cut Mode, open the PrintHub program.

1. Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the

printer main board so you will not be able to access it unless the printer is turned on and properly

communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

3. Click on the Label Feed Tab.

4. Click on the Output/Cut Mode button. There are different options available which change if the

Cutter is enabled or disabled. If the Cutter is disabled, the label present options will be available. If

the Cutter is enabled the present options are no longer available but cut options become available.

Cutter Options

D Primera PrimtHub

LXB10
Color Label 610 - Idle
Color Label &30 v
Rucue Pnnt Allgnment Lalbel Faad
Lensor Mode-
B
T
Continuous Reflective

Precent hMode:
[ Cutter Cnabled

Cul after butlon press

Cut after label count

Cul aller no activily

Cut after every labsl

Cut after button press. This setting will cut after you press the Load/Feed button on the printer. This can

be used after one label or an entire job. This feature is useful if you will not be present at the end of the print

to catch the cut label.
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Cut after label count. This option will cut after the number of labels specified in the toggle box that
appears when this option is selected. This is useful if you have front/back labels or sets of labels.

Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another
print job within one second of the last print job in the queue. You can use this feature to cut at the end of
multi-copy job, multi-page job or multiple individual jobs in the queue.

Cut every label. This setting will cut after every label.

Present Options

D Primera PrintHub
LXE10
Color Label 610 - Idle
Color Label 810 L
Queue | Print Alignment | Label Feed | Printer Setings
Sersor Mode
™ M !
| = v
e
Confinems Relle live DiieCul
Present Made (
|| Cutter Cnabled
Do not present Precent atter no actnaty

Do not present. In this mode the label stock does not move after the last label is printed. This means that
part of the last label printed is still in the printer. This should be used only if you have a label rewinder
attached.

Present after no activity. This setting will present (feed all printed labels past the front opening) at the end
of a print job if the printer does not receive another print job within one second of the last print job in the
queue. You can use this feature to present at the end of a multi-copy job, a multipage job or multiple
individual jobs in the queue.
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3E Adjusting Print Alignment

If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper
you probably are not familiar with an essential part of a label printing - Print Alignment. Standard printers
feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the
sheet. This is to avoid any need for alignment.

The LX610 senses the beginning of the label with an optical sensor and is capable of printing to top, bot-
tom, left and right edge. Because of this it is necessary to align the printer to work with specific types of

label stock.

The LX610e comes factory calibrated to print exactly to the edge of Primera label stock. However, due to
variations in the left margins and other variables it may be necessary to fine tune these settings at the
beginning of each roll. This is especially true for other non-Primera brand label stock.

Adjust print alignment using the PrintHub. Go to the Print Alignment Tab (second tab).

7 Prirmess PertHut = (u] »

LEEID

: Color Label 810 - Idle
Coioe Laba! 610

e
= E 50%
- +
—F
Left Marges {ren] _¢_ E *+
Align  Chasge  Clean

o|§_g+1

Top of Farm (el —

aris Cirding
+ n ™
o H I Tear OF Pogition A
Ombine Oy ’ # Ay,
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Click on Test Alignment to print the alignment shown to the right. Look at the print to determine how much
white space is visible on the edges. The black lines should print right on the leading edge and left edge. In
this example the Top of Form needs approximately - 10.

S
H ; . LEFT OFFSET
1. Left Margin Offset. This value moves the printed label left
or right. Add to the current value to move the printed label
urits TOF
to the right. Subtract from the current value to move the | DRy i I
printed label to the left. ;
I y
/
<
Adjust
2. Top of Form (TOF). This value moves the print start position Top of Form -10
up or down on the label. Add to the current value to move

the printed label down or toward the printer. Subtract from the current value to move the
printed label up or away from the printer. The value is automatically saved as soon as you

set it. You may have to make several adjustments to one or more of these values. After each
adjustment you can click the Test Alignment button to print a small test pattern on the label.
This will help you find the proper alignment value.

3. Tear off/Cut Position. This value adjusts the position of the last label printed after it has been
presented. This only applies if the output mode is set to “Present the label” Add to the current value
to move the tear point closer to the printer. Subtract from the current value to move the tear point
away from the printer. The value is automatically saved as soon as you set it.
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3F PrintHub Settings

General application settings that apply to the software and all printers can be found by clicking the blue
“Settings” button in the lower left. Printer specific settings can be found on the “Printer Settings”Tab. See

next section.

Language. Typically, the language is set to match the language setting in the operating system.
However, you can override currency settings on the Language Tab.

Automatic Updates. Automatic Updates will update PrintHub, the printer driver and the printer
firmware. Every 7 days you will be prompted to update the software if there are any newer
versions. You can choose to increase or decrease that automate check. You can also perform a
check for updates immediately by clicking the “Check for Updates” button. Finally, if you would like

to receive beta software check the “Check for Beta updates” box

| 2 Prnesa Prantiuts

L&
Calor Label 610 - |dle

Cokor Laba 630 e

Cusue | Frint Algrment | Label Feed | RFID | Printer Setting

B oo beteren sutorcheck fer updates

[ Chack for Bats updates

EE==

Software Wersion: 1.3.0.22

N | lln.nﬁ.tmnm

(] Oniee Sy [ 1ot ogrment_| ’
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Printing Preferences. You can choose to close PrintHub after printing completes by checking the “Close
this application after printing completes” box. PrintHub automatically opens whenever you send a print job
to the printer. If you do not want PrintHub to open in front of other programs, you can check the “Launch
minimized during print” option.

Support. Click the “Generate Support Report” button to generate a zip file on your desktop containing all
recent log files. Send this to tech support so they can help solve any printing problems.

Advanced. Check the “Generate Printer Status XML" box to create an XML at
“C:\ProgramData\PTI\PrintHub\PrinterStatus.xml”.

Software developers can use this file to display status information such as error messages and ink levels in

3rd party applications.
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3G PrintHub Printer Settings

Printer settings can be found in Primera Print Hub on the Printer Settings Tab for the LX610e.

| [E) Prirvstsn frnthiut

LEeM
r . Y i
o " Color Label 610 - Idle / (‘“ Cigial ie-E18 Madis

Qo | Pricsalonmens | Lasl Pesd | Prinoer Secings

Lt ]
Buiver Color Laked £30 {100
[ 137 11473078 () 1108
Sebrind Phsrritgs
Sofsadas Versan 1481 0%

[ Cmine ey

Information. This section displays all current driver, software and firmware versions.

Advanced Setting Button. Click the Advanced Settings button to view the following settings.

D Advanced Setings for Colar Label 510 -

General Settings

Ut et e ] o |

Resture Factury Defaalls

Cartridge Settings

Sconds betwien Munlensoce Tpdi 3

Pages between Muntengnce Wipes 10
o Suppress Alignment

Stock Feed Sattings

Rall Faed Spaad (0.1 infeet) « B
Feed Speed (01 infeed) « B
Prink Speedd #1 infaee) « B
Heverse Speed (0.1 infsec) o B
Veestical Printt Adjust (FRHH) s B
X Cutter Settings
Knifie Prestre o B
Knife Shrelch Eactor o B
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General Settings

3G1. Multiple Printer Support.

You can install multiple printers to the same computer and use them simultaneously. To do so you will need
to change the USB serial number identifier of one of the two printers, two of three printers, three of four
printers etc. To change serial numbers:

1. Connect each new printer one at a time. The current USB Serial Number will be displayed.

2. Click Generate. It will find the next available USB Serial Number based on the currently connected
printers. For the first one it should set it to 2 and for the next printer 3 and so on.

3. Click Set. You will hear the printer reset and the settings window will turn gray. After it resets you
will be able to see the settings window again. Keep the printer connected.

4. Now you can connect the next printer. Windows will automatically install a new driver for that new
printer and name it Color Label 610 (Copy 1). You can rename it later by editing the printer
properties in the Windows printer list.

5. You will now see a second printer appear in the left column - Color Label 610 (Copy 1). Click on it to
display information about this printer. If this is the last printer, you will connect you are done. If you
wish to connect additional printers follow through steps 2-4.

Restore Factory Defaults. This will set all Print alignment and other calibration settings back to factory
defaults.

Cartridge Settings. Here you can adjust the frequency of certain maintenance operations. Increasing the
value of “Seconds between Maintenance Spits” will decrease ink usage but could also cause poor quality
printing.

Increasing or Pages between Maintenance Wipes will speed up printing but could also cause poor quality
printing.

Check the Suppress Alignment message to prevent the window from appearing which prompts you to
align the cartridge every time a new cartridge is installed. Skipping the alignment is faster but can result in
poor print quality.
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Stock Feed Settings.
Adjust these settings only if directed to do so by Tech Support.

Calibrate the paper sensor if you are receiving TOF errors. The calibration process will prompt you to remove
all paper/stock from the printer before calibrating.
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Section 4 Printing and Cutting with PTCreate

PTCreate is everything you will need to layout your prints and cuts for your LX610e. It can be used to print
only or Print and Cut. Every object that you place in your layout, can be set to print only, cut only or Print
and Cut. There are two different versions. The Standard version comes with the printer. The Professional ver-
sion can be purchased. Both require an activation code. The activation code for the Standard version that
came with your printer can be found on a label attached to the bottom of your printer and with the printed
documentation that comes with your printer.

4A Overview (Standard version vs Pro version)

oLD KING’s

LONDON
DRY GIMN

S —
e ¢ o i s g
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Layers. (Pro Version Only) Layers allows you to see and manipulate layers of importedSVG files or
elements added within PTCreate. SVG files can be created in programs likeAdobe Illustrator.

Import and Trace. Import allows you to flat files (Pro and Standard) and vector files (Pro Only)
which can be a graphic you would like to print, a cut file or both in the same file. Trace allows you
to create a cut file be tracing a JPG, BMP or TIF or other flat file that you have imported. This is a
great option for creating complex cut files without needing another expensive and complex
design program.

Advanced Design Tools. (Pro Version Only) Advanced design tools such as Gradient, Eye Dropper,

Eraser, Freehand drawing and the Shape Node Tool allow you to create your own design in
PTCreate.

Document, Position and Size, Fill and Stroke, Style, Text. These tabs all manipulate existing
objects on the page. Document controls the artboard or page size. Position and size allow you to
precisely move objects on the page. Fill and stroke allows you to change the color of lines. Style
allows you to change whether a particular object should be cut, printed or both. Text allows you
the change font and size of text objects.

DUOCUMENT

F

POSITION & SIZE
™

Page Size: |ELE:lJnm Size..,

Orientation: | Vertical (Portrait) w

iks: Inches "
Nudge: | 4 P A w Liniks:
Haion:| B & | o A show Grid
To Page L _ ] )
vaign:| IF = (B Gnd Lines: | 6.001n : |

Subdivision: | b =

ORI\ QP

OB @+

(20— Ushoncuteoes [ i
Keep Proportions
H: | 2.125in >
Winrkepace Alpha:
| i
rowmte: ¥ LR Apr 5 &
[ show Cutlines Gy

a. Document. Use this tab to adjust the page size after it has already been setup. Sometimes
you may need to increase the height the page to accommodate a bleed or multiple rows.

b. Position and Size. You will use this tab to move both the cut line and the image on the page.
It is much easier than trying to drag and drop images manually.
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FILL & STROKE STYLE
e
Fi: [l B\ D : D
: Style: MNormal v
Opadity: g | w002 l;. |
LI,
Stroke: | Cubor - - [: -1“" | DWEH
e _P'I
Opaaity: B|mwwls és Clipping: | Naone |
Width: | 100 |2 ] Cut Line Type: |Cut only e &
;A Print onl —J
s [1E] (] [ AA) EﬁﬁH @
— rin
Miter: | 00 = @ - _
endcop: [m| [ [ &)

L_ne:-'.nrle:|— v| Feit

c. Fill and Stroke. Use this to change the line style of the cut. For the most part you should
leave these settings at their defaults. If you are having trouble seeing your cut line, you can
change the color of it here.

d. Style. Here you can designate whether any object should be Print, Cut or both. By default all
images imported using the import icon will be set to Print. Also, all objects drawn using the
rectangle or circle tool will be set to Cut. However, this tab will allow you to adjust this if
necessary.

e. Text. The text tab allows you to adjust the font, size and other properties of text. Text can be
added using the Text tool from the left side tool bar.
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Library. The library contains some preset
shapes that you can apply to your
document as cut objects or print objects.

Page Layout. This area shows your actual
image. You can move objects here by
clicking and dragging. You can also see
where the cut will be made in relation to
your print. In the example above the cut
line is highlighted red and inset
(overbled) slightly so there will unprinted
area on the label

s 0 ®0|-»

TEXT

View: Al

<

Font: | Aral abcdeABCDE - | |4

JECNE

Aignment: | = | = | (= [ E
Sizing: Standard s

T s

A v

Ay Traddng: | 100.00 %% |2

Ei leading: | 0.00n =

AL VOfet
Rotate: | Rotate W

>

SR NEE W

| 49



4B PTCreate Software Activation

You will need to activate either the Standard or Pro versions of your PTCreate software.
If you purchase the Pro Version you will be sent an activation code in your purchase confirmation.

If you use the Standard Version you will find your activation code on a card in printed material that came
with your printer -OR- on a label placed on the bottom of your printer.

To Activate follow the activation prompt that appears when you open the software or go to the

Help Menu - Activate

PTCreate Demo Mode

“PTCreate”™ will run in Demo Mode until the software is activated with a
valid Activation Code.

In Demo Mode:
Cutting is disabled

3 PTCreate: Untitled-1
File Edit Object Path Effects Tea View Cutter Window Help

X il % T : About PTCreaks...
e o binln . l

Support *
Register Product
Check for Updates
m lru'u]lllgr ¥ -
T Purchase Pro Upgrade —
Fl
Purchase License...
=,
[

An activation windows will appear. Enter your 30 digit activation with the dashes included. Click OK.
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Activate PTCreate Pro... X

Please enter your Mame and Activation Code.

Mame: [John Smith |

Activation Code:  [[123456-123456-123456-1234561123456 |

[ ] Activate manually | Cancel | | QK

If you are unable to activate, check the Activate manually option, and obtain your
Activation code at:

http ./ www .craftedge.com/activation./primera

The software is now activated on this computer.

Important Note: Activation requires internet access!
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AC Software Deactivation

To move the activation to another computer you will need first remove the activation from this computer.

To remove activation, go the Help Menu - Deactivate...

B PXCreate Pro: Untitled-1
Pl

Ednt Cbject Path  Layer Page Effects

Bext View Cutter ‘Wendow | Help

Hrlp E1

Register Product
Check for Updates
Language 2

A confirmation prompt will appear.

e Deactivate

Are you sure you want to deactivate the software?

Deactivating will allow you to re-install on a different
computer. (Requires an Internet connection)

Yes | I Mo

Important Note: Deactivation requires internet access!

If you are unable to deactivate because of a computer crash, please contact tech support to receive another
activation code. If you have the Pro version, please have your order number ready to speed up the process.
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4D Tutorial How to setup a Print and Cut in PTCreate Standard

This tutorial will walk you through the basic steps to print and cut a label.

4D.1 Choosing a Label Size (Page Layout)

After you activate your software you will be prompted to open or create a new project.

1. Choose New Project...

Mew Project... Click "Mew Project” to etart a new blank project with default cettings.
G Cpen Praject... Click "Open Project™ tn continue working on an existing project.
Recovered Projects... Continue working on recovered prajecte.
Recent Projects Clear Revenl

2. Setyour page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 3 to accommodate
approximately a 4” x 3" label.

Mew Project

Name: | Untitled-1 |

Tip! Set your page larger than the
/ label size to be cut. This will allow

Page Sz=: | S:ZE' - - you to create a bleed around the
We :";g ; ;_ label so that you always cut inside
" ey your print and get perfect cut every

H: [4.25"x 4" time.

425" x 6"
Orientation: |4.25" x 8"
4,25% x 127
Units: Custom Size..,
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3. Toset the page height or width to a custom size type the size in the W: and H: boxes or toggle the
size up or down with the arrows.

Mew Project

Mame: | Untitled-1

Page Size: |Custom Size... e
w: | 4.25in =
H: | 10.000in :
Orientation: | Vertical (Portrait) ~
Units: | Inches bl

4D.2 Import a flat Image (JPG, BMP, PNG, TIF, GIF)

PTCreate Standard allows you to import flat files for printing only. You can import the following image
formats: JPG, BMP, PNG, TIF, GIF.

Important Note: Primera recommends imported images are at least 300 DPI. The software is optimized for
this size. Larger DPl images can be manually resized. Smaller DPl images will not utilize the maximum
quality of the printer and may appear pixelated. Images downloaded from websites are typically made to
display only onscreen load quickly so they are typically only 72 DPI.
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To import an image for printing follow these steps.

1. Go to the File Menu or shortcut bar, choose Import.

(3 PTCreate: Untitled-1

| File Ubyect Path Eftects ledt WView Cutter Window Help
Mew Project Crl+MN
Open Project... Ctr+Q
Close Project Ctrle W
Close All Projects Ctrl+Shift+W
Save Project Clrl+5
Save Project As... Ctrl+5Shitt+5

Revert

Preview
Print Setup...
Print

Recent Projects

Eait

2.

Ctri+ Shift+P

Browse to the file you would like to use and choose Open.

LR -

3 Open *,
4+ w Label Samples » 4x3 » v & Seachdxd B
Organize » Mew folder E- O @
= YeHakDOMUIUSE(F ™  Mame "
R ey
Rale_hk hi —
= Mklg [Viptech E beerjpy
5 Apps (ptechts) (Vi) E Riscolti dx3 g
= ECO_Docs (Vipteche [E Black-Eyed Peas d53.jpy
== Crystal Access (\\Pte [E bux_mly d43.jpy
= Tech_Support (\iptes IE Brownie Chocolate Crunch 423 pyg
= Mg (WPTECHFS) (Z: E Brownie Chucolate Crunch Alteinate
E Brownie Chocolate Crunch Sales Gift
_‘ Hetwork E Drownie Truffle 4x3 jpg o

>

File name: |Brmrﬁe Chocolate Crunch 4x3.jpg

u| |MI Images
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3. The file will appear on your page layout.

4. You can manually move it on your page or increase the size. However, a better option is to use the
Position and Size window. Set the size to match the size of the page layout. In this case set the
width to 3.25”and check the Keep Proportions box.

Y e —— =

| e dm Cwnn e e Fel Vi Come A ey

A e b

& Eﬁ@ﬂ‘m

5. Center the image horizontally and vertically to the Page.

YT r— - B

B U Enea P BTe Bl i ol s ey

L

L

CIAF|F

CERG+L |
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4D.3 Add a Cut file

In PTCreate Standard you can either draw a box in the approximate location of the cut file or use one of the
preset size from the library. If you have a rectangular label or you would like to add a corner radius to your
cut it is preferable to draw the cut line. Corner radius make it easier toremove your label from the liner. In
this example we will draw the cut line.

1. RIGHT CLICK on the rectangle icon and choose Rounded Rectangle.

Ll 2 o
?'-(_‘.-J"‘ tocotale ?{ ~ LT (/
S WEL I '

F - cnall

2. Before you start to draw the cut line, adjust the corner radius. You will not be able to change this
after you draw your cut line. The corner radius is the amount of curve around the corners..125 in
(1/8 Inch) is the standard corner radius.

(3 PTCreate: Untitled-1
File Edit Object Path Effects Text View Cutter W

Rectangle Corner Radius:

Untitled-1 €3 || e

ol

1 &0
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Draw the cut line by hovering your mouse over the top left corner of your design. When you are
ready to start, left click and hold to start the rounded rectangle box. Keep holding the left mouse
button and move to the lower right corner of your design. Let go of the mouse button when your
box is the approximate size you would like it. We will adjust the exact size and position in the next
step but to maintain a proper corner radius it is important to get as close as possible in this step.

@ Pl Uraties-1 = =] b

Fde fdt Obgect Path et Ted View ot Window  Halp

Start here

Ly i " oo
r____.-".fr' cofcde I—

CENICHU ]

@ Ptroste Unsittid -+ o =
Fle B COhgnt Peh Effeti Ted Wiew Cultei Wisdow Help

L

SESE|A

- prearedel Do coiites

OERIC®L |
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Once the cut line is in place you can adjust its size and positon. Whatever size you choose will be
the exact size of final cut label. A typical overbleed is 1/16" This will ensure that the cut is
completely within the printed label every time so you have no white space around the edges.

a.  First select the cut line using the arrow tool. TIP: If you are having trouble selecting the object,
first select any object and then press the TAB key to move the selection from object to object.

b. Then change the size. Adjust the size to 1/16 (.0625") less than the height and width of the
print.In this example the cut file would be 3.937 x 2.937. You may have to uncheck the Keep
Proportions box.

¢.  Finally adjust the position by centering horizontal and vertical alignment to Page.

B FIC e Urtiiad-1 [m] ®

Fie B Oyt Paih ENects Tod Veew  Culbn ‘Window Help

RO
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4D.4 Print.

To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The print dialog will
appear. Make sure Print+Cut is selected. Click the Properties button to access the printer settings such as
Print Quality, Saturation and Color Matching. For a full explanation of printer driver settings see section 5E

B3 Print

MName: Color |ahel 610

Satus: Ready
Type: Color Label 610
VWhere:  USHBO0Y

Print range:

Fages

() Selection

Prirdt + Cut

[ Print cuthines only
[ Print. sedection only

x

Vp..,,m,,.-—-""

Note: Before printing we recommend
clicking the print Preview Button
described in section 4H
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4E: Tutorial: How to Setup a Print and Cut using PTCreate Pro - Vector File Cut

If you have a designer that is able to use an advanced program like Adobe lllustrator or Corel Draw, you can
save your print file and cut file together as a multi-layer vector file in Al, EPS, or SVG format.

You can then import them into PTCreate and designate which layer will be the cut and which will be the
print. This will allow you to create complex cuts in exactly the right shape and exactly the right position.
This method is the best way to get the highest quality print and cut. While tracing the image using the steps
in the previous section will allow you to create the same shapes, you can save time and create a smoother
cut file using this method.

LAYERS

T
& - I = | ¥ (=) PRM-dark-herd-coffee. ai

o0

i » b [G] <dipped>

Cut Layer i
Print Layer

Important Note: Before you start with PTCreate, your designer should create the print and cut line
togetherand save them as two separate layers in the same file. You'll be able to see these layers when you
import the file into PTCreate.
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4E.1 Choosing a Label Size (Page Layout)

After you activate your software you will be prompted to open or create a new project.

1. Choose New Project...

ik P Brciiect” o s | s e blanik project wilh defaull velings,
Dpeen Prgrjech, .. ek "Open Project” Lo oo lirees veorking on an exiling praject,

Reververed Projects... Comntinue working on recevsered projects.

Aecent Projects Clear Recenl

2. Setyour page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 6 to accommodate
approximately a 4" x 6” label.

Mew Mroject Tip! Set your page larger
than the label size to be
Mame: | Untided-1 cut. This will allow you to

—— v create a bleed around the
o T label so that you always cut
We |25y 2" inside your print and get
perfect cut every time.

H: [425"x4"
425" x 6"
Orientation: |4.258"x8"
425 % 127

Units: | stom size. .

Concel | | oK |

3. To set the page height or width to a custom size type the size in the W: and H: boxes or toggle the
size up or down with the arrows.

Mew Project
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4E.2 Import a flat Image (JPG, BMP, PNG, TIF, GIF)

PTCreate Pro allows you to import vector files for printing and cutting. You can import the following vector
image formats: PDF, Al, EPS, SVG

To import an image for printing follow these steps.

1. Go to the File Menu or shortcut bar, choose Import.

3 PTCreste: Untitled-1
File Fdit Ohbject Path Fffects Test  View Cutter Window Help

Mew Project Ctrd+N
Open Project... Ctrie0
Cluse Projpect Cll+=W

Cloze All Projects Ctrl+Shaft+-W

Save Project Ctrl+5
Save Project Ac... Ctrl+5hift+5
Revert

Chrl+ Shift+ P

Freview
Print Setup...
Fnnt

Recent Projects »

Eat

2. Browse to the file you would like to use and choose Open.

B Open o
Lockin: | Gamgle Labels «| @ & o M=
Mame = Date modified Type - :
* Sarriphes 2008 229 P File Rolder M Mh
Cuickacces M- duck-herd-coffee.ai SN ZPM  Adobe st
¥l & FRM- dark-herd- coffee dielinesng SIWINGEHPM 6 Documes
.trpaujumﬁurh:al SN 1250 P Adobe Husira
Desktop 2 Repose Kombuchatvg SIS IZ52PM  SVG Dodumer
- W Fepone_Orange_band.ai SINANG 2 PM Adobe Bt
m &' Repose_Orange_band sg SIS 2MPM VG Documer
Libeasie
This PC
‘ 40x58n,
Nu.mnrk
L4 ¥
Fit e [ Prbt ok trdcoffee “|  [Copen ]
Fies of type Al Binaciable Fisy v el

|63



3. The file will appear on your page layout. You can manually move it on your page or increase the
size. However, a better option is to use the Position and Size window. Set the size to match the size
of the page layout. In this case center the image to the page.

3 PTCrmm Py Lingirins-1 - @ X
| B B Ome Peb Lom Bies Ted YVes Coflo Tsdew  Helo

Hardes dvaronl

]

DARK HERD
Gogpee Roaslzis

- o AR ET

B RN N

HOUSE DLEND BARK

ETHIGPIAN S1DAMA
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4E.3 Working with Layers in an Imported Vector File

Once you have imported the vector file you view the layers in the layers window.

The cut file must separated from the design at the top level. It cannot be buried
under other layers that will be printed. In this example the cut line layer is setup

in lllustrator as an Outline instead of a Fill. Either will work but Outline is Outline
preferable.

1. Toview the sublayers and find the cut line click on the arrow to open up the group.

@ PTCrate Fr . o =
e ik Ot Ptk Layer fac Tod View Cofler Window baip

-
.-
woge (4 b & W
iy i
= & s Syl
e [ B #
[ 1w m
h : e Progortors @

DI MT|0%|DeN Ro|47T

DARK HERD
Cofgee Roailors

MADE IN THE MIDWERT

HOLUSE BLEMND DARK

Click Arrow to open layer groups

Note: Before printing we recommend clicking the print Preview Button described in section 4H
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2. Once you find the cut line, select that layer and click the style tab above.
a. Choose Cut Only!

b. Set Style to Blackout.

3.  Now select the Print layer, click on the stye tab above and choose Print Only!

STVLE &

]

STYLE El

>

SAYEE IEN
i
S\ TN

Sryle: | Hiacknit v/

Style: I'Ahrmd \J:

Eh@w-m
N\

Layer to be Cut

@
=

Layer to be Printed

4. To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The print
dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the print

er settings such as Print Quality, Saturation and Color Matching. For a full explanation of printer
driver settings see section 5F.
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4F Tutorial: How to Setup a Print and Cut using PTCreate Pro — Contour Cut

This tutorial will walk you through the basic steps to print and cut a label using the trace image / contour
cut feature found in the Professional version of PTCreate.

4F.1 Choosing a Label Size (Page Layout)

1. Choose New Project...

Mew Praject... Chek Mew Project” B start a new blank project vath default settings.
Dpen Project. .. Chck "Open Project” o conliroe working on an exisling projecl.
Recovered Projects... Contirue workasg on recovered projecis,
Fospent Projects Chear Recenl

2. Setyour page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 4.25 to accommodate
approximately a 4" x 4" label.

hless Bacject Tip! Set your page larger than the label size

to be cut. This will allow you to create a

MName: |
| Liged 2 bleed around the label so that you always

Page Size: |msm Size... v cut inside your print and get perfect cut
every time.
w: [+25n %
H: |425in %
Crientation: | Vertical (Portrait) e
Units:  |Inches w
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3. Toset the page height or width to a custom size type the size in the W: and H: boxes or toggle the
size up or down with the arrows.

Mew Project

Name: | Untithed-1

Page Size: | Custom Size...

Ww: | 4.35in =

Ak

H: | 10.000in

Orientation:  Vertical (Portrait)

Units: | Inches w

e | 3]

4F.2 Import an Image.

PTCreate Pro allows you to import flat files and vector files. You can import the following image formats: Al,
EPS, PDF, SVG, JPG, BMP, PNG, TIF, GIF.

Important Note: Primera recommends imported images are at least 300 DPI. The software is optimized for
this size. Larger DPl images can be manually resized. Smaller DPI images will not utilize the maximum quali-
ty of the printer and may appear pixelated. Images downloaded from websites are typically made to display
only onscreen load quickly so they are typically only 72 DPI.
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To import an image for printing follow these steps.

1. Go to the File Menu or shortcut bar, choose Import.

3 PTCreste: Untitled-1
File Fdit Ohbject Path Fffects Test  View Cutter Window Help

Mew Project Ctrl+N
Open Project... Ctri+ 0
Cluse Projpect Cll+=W

Cloze All Projects Ctrl+Shaft+-W

Save Project Ctrl+5
Save Project As... Ctrl+5hift+5
Revert

Freview Crl+ Shitt+ P
Print Setup...

Fnnt

Recent Projects »

Eat

2. Browse to the file you would like to use and choose Open.

B Cpen =
Lockcin: | | | Label Desgra «] @& O
* Hame " Detr encdiied Type
} Strean Labels with WG die cut files 1 IANTS 39 P File folder
Cuick secess i 511 cananer.prg IO RIT AM PG File
6§10 gotferprg WL R0 AM  PNG File
) & 610 gin.png AT AM  PNG File
Desktep ﬂ KeenKine=Goatine-ds.prg BES1E50REM  PNG File
- u keenkine GeatSne-Shipng 2015 153 PM PNG File
e & Kidhesd_SuperHers_lpng 1VIZZIZON 15T P PHG File
Likwariey ] idHnad_SuperiHers 2 png 182273008 151 BB NG File
ul KigHesd SuperHers_png 2L 1S P PG File
!_ & MaturalDeganic-Cregans (TLpng BSA0IGEITPM  PHG File
This BC ﬂ MaturalCeganic-Oregans (1l png GEGI5IPM PNGFile
il PRI dark-herd- otfee U3 edits g WIH2OG IS AM PG File
‘ g PRMA-FreshTaste-Coffee-Tabe png NS00 1119 AM  PRG File
i ; & PRM:Repoie-Tea-LakelC5 scite cut linepng W0 E30PM PHG File
g Tumpolmq__mm.pﬁg TN Bl a0 PG File
& WaterPurk_SplashBash_1b png TV/UI/Z009 Bl AW PG File
& WaterPark_SplachBash .png A0 3 AM  BNGFile
i >
Fie ruame. [ WetesP_SlashBuash_2 erg o |
Flen of typem A Peadable Fies - Lol
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3. The file will appear on your page layout.

4. You can manually move it on your page or increase the size. However, a better option is to use the
Position and Size window. Set the size to match the size of the page layout. In this case set the
width to 4” and check the Keep Proportions box.

| 1B FICiate P Urtithe«) - o =
| Fie Bde Chact Peh Lo [Axs Isc Vs (uter Windos  Halp

DEMU|UN|D RN wo|-a00F
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5. Center the image horizontally and vertically to the Page.

w [amen

remic (I OB P (Y (DX

DFEMU|UN|D RN vol-s8 0

SPLASHBASH |

ATERPARE
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4F.3 Trace Image and create Cut Line

Tracing the images requires a flat file such as BMP, GIF, JPG or PNG.

1. Select the image object that you just imported. This is very important. You'll know it is selected
when the bounding box appears around the image. Now click on the Trace Icon.

<]

Filg Edi Object Path  Layer EHects Tet View Cutter ‘Windew Help

SN* o ble

Dn|DeNSe|sa9

2. There are many options available in the Trace Image window. However, the most important option
is the Contrast. You should adjust the contrast until the preview shows a single green highlighted
image in the shape you would like to cut.

B Tiace Image =
Irpurt Outpuit
e A hemw hodes Medes: 55
Wanerpari_SpiashEash_2.png Show Source Inaee: I
100 x 1 : :
(uein el @ Q| Reset ask
Image Setirgs EdtMode:  hone o
= Lise Algha Channel
Mode; | Monochrome ITIWM: o
| canrast 2538 |
Resargie: | x 1.0 (o) w Dempeciie
Clebgh Pocss Fiter 1 |2
Output Sattngs
Sooth (1-300): (75 o
Detad o100} [38  f0
Srgle Lne Threshok: [0 (2] . . =
Bresk: Apart Outines el mackouit The preview i curmently showing what wil be
[;] ik Lipdate Preview | oo D0 o et Previes bution o soe
[ ke mngre Lawer {Pring +Cut) trace result.
Restoce Settngs | Save B8 SVG... [evemps s contrum waang Cancel E
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3. Click Update Preview to show the cut lines and the number of points/nodes in your cut file
(if you check Show Nodes). These nodes are the points on your image to which the knife will travel
to cut the label. Don’t worry if your cut line isn't exactly in the right position or size. We'll adjust
that later. At this point you are just looking for smooth lines that represent the correct shape.
B Tesce Image ®
Input Dt
hease an image.. [Esom toces Herdes: 55 |
VWoterPark_SclastBach_2.00g Sham Saurc Image: [ ]
et @l |l | Fnent Hack
L Sxlhira Ll Hode: | N ¥
Mode: [Menscheia ~ e ! "
Conast (3-2585 | I ECE
Rl Choesecae
Olrghremsrier & |3
Dol Betings
‘Epsaeriy - 300 75 -1-'
Detsd (0-100r |98
Gnghs Lne Theashekt: [0 03] . 43
SR e o G e pane e e
Restore Settngs | | Save 85 5V [CIremet b contius tracng Careel L
4. Note the difference in the preview when you increase and decrease the contrast.
B Tesce Image x
Input ‘Dutut
Choose animage._. e Metee e
etk _Splashbiash_2ery S f0urce sk 1
b @ allg e
Image Geitings Bt bode: _!l!t et
Made: |Menodworee - [ e .
| comemt p25: (HEEE
Resarie: | x LI (o] [ [ Cespacide
Clrhrmarite 1 f2
et Settnge.
Smocth im0 (B
el gl [® (3]
Sngle Lne Threshakds |2 18] v s X
e T s meve e
Restore Sesegs | | Sawe 88 5VG... [JPeompt to connse iracing Cancel o

shape detection and end up with a rectangle cut.

Contrast to High: If contrast is too high you will lose the
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B Tesce Image

Trput Dutut
o = = ] shaas hasdes: Hedes: 359
etk _Splashbiash_2ery S f0urce sk 1
1800 x 1 ol
b ala | e
Image Setings Bt Mode: | None -
=y e Al Charrd '
Hage: |Mermdhome - [ bt avudbiel .
Jconmnt g8 1 [ | :
Pesargie:  x L0 Moee]
Cltoh P Fiter 1 |3
Dutgut fettings
Smocth B0k | T [
Detsd (020} (% 5
Sngle Lne Threshakds |2 18] X
L4 >
] ek Auar Custines [ ket The preview is cumendy thossng what wil be
: [edaie mreien | oo 5o £ Licate Frevien bution 1o e
(] s Ermape Livper (Prie o) [resy=
Fesiee Settegs | | Save 38 VG, [ Prompt tn contras fracng Cancel o

Contrast to Low: If contrast is too low you will end up with
extra cut lines outside of the main cut and potentially the
wrong shape. In this example the cut line is tracing the wrong
part of the image.

5. Click OK when you are happy with the shape of your cut line. The cut line will appear on top of your

image as a red outline. You'll see a trace layer appear in the layer window.

T —
| i O e G n e Wes e Sedes sen

S0 ST[ON|FeNN=|7D
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4F.4 Offset a Cut Path

1. Now you'll need to offset the cut line inside your image so that you'll have a bleed. With the cut line
selected go to the Path Menu and select Offset.

(3 PTCreste Pro: Untitled-1
File  Edst []hrdq.ﬂh Layer Effects Ted View Cutter Window Help

Urnoan A=l =
Intersection
Exclude
S Frant Minus Back
SR bt Back Minus Front

untiedd B Simplify..
—_ Split Path
Reverse Fath
Obyject to Path
Close Path
lain Paths

JE "N Ne |5 53

P e

2. On the Path Offset Window, check the Inset Offset box and adjust the amount of offset. For this
image we chose 0.040 inches. You'll see a preview of the new position of the cut line in black.

Oﬂ_l'ﬂ'lﬂ *\l_!] h\\}l_-i-ﬁﬂ

w I8
s Y|
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3. (lick OK to change the Offset. The new cut line will appear.

Note: Before printing we recommend
clicking the print Preview Button
described in section 4H

{sPLASHBASH]
NQ WATERPARK

4. To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The print
dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the

printer settings such as Print Quality, Saturation and Color Matching. For a full explanation of
printer driver settings see section 5F.
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4G Setup multiple identical cuts (Duplicate and Array)

If you intend to print and cut a smaller label such a 2" circle you may want to duplicate that image and cut
line across the page so that you don’t waste material. No matter what your label size is your page size for
die cutting is always 4.25”". It makes sense to fill up that page with as many labels across as you can. Follow
these steps to Duplicate images and cut across the page.

1. Create your page size. In this example we chose 4.25"x 4.25". You can choose a custom size to fit
your labels. In this case we wanted to choose a height that was able to accommodate 2 rows and
two columns of 2.125 x 2.125 cut to 2" x 2"

Mew Project

Mame: | Untited-3

Page Size: | Custom Size... e
w: [4.25in -
H: [4.25in k|
Crientation: | Vertical (Portrait) ~
Units: | Inches =

2. Import your image using the import Icon.
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3. Set the Size and Position. In this example we are setting the size to 2.125 x 2.125. Center the image
horizontally and vertically.

PTC reske: Unisled- —p [m ] o
B

Fde Edit Obgect Path FMecti Test Veew Culter Window Halp

R EI-T g -

momte: ([ IR - (R [

4. Create your cut line using the shape tool on the left size tool bar. Right click on the rectangle icon
and choose the circle tool.

5. Draw the circle close to the size of the images. @ PTCreate: Untitled-3
You don't have to be accurate on this step since File Edit Object Path Effects Text View
we will be changing the size and position in the
next step.

Rectangle Comer Radius: | 0.125in 5
6. Set the size to correspond to the actual cut label

size you would like. In this case we set the size to
2"x 2 so that we have a standard 1/16” bleed
around the label. Uncheck the Keep Proportions
box. This will make sure that no labels have any
white unprinted areas around the edges.
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7. Center the cut line horizontally to the page
@ FiCrests Urtisted-3 - 0 =

File B Oject Paim EMerts Tet Wiew Cuther Windsw  Help

8. Using the arrow tool select both image and the cut line by drawing a box around them.

I
| @ FTCiae Untitied:3
™ fde Obpect Path [ffecis Ted View Cutber Window balp
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9. Group them together by going to the Object Menu — Group. This will ensure that cut says with the
image and in the correct relative location while we move and duplicate the image in the next

steps.
3 PTCreate Untitled-3

File Edit | Objest Path Effects Tex View Cutter Window Help

Transtarm ¥
Arrange -3
Alignment >
Dustnbute »

Ungroup E Clul Shift+ G

el =

—_ Break Apart Cil=B
Merge Curl+Shift«B

T‘

9, Clip Path »

@ | Clip Mask »

= ] Duplicate... Ctrl+ D

{y [}l.lp[ltltl: Rotated... Chrl+ Shitt+0}
Hude

] Shewe All
L3 Lock CtrleAltsl

Unlock All Ctrl= Alt+ Shifts L

Remaove Effects

10. Align the group image and cut line to the upper left corner.

I
| @ PTG Untitied:3 = B &
| s fg8 Object Puth ifects Te View Cotter Window Help
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11.

12.

13.

14.

Now go to the Object Menu and click Duplicate. Make sure the image and cut line are still selected

otherwise the Duplicate item will not be available.

Set the number of rows and columns.

In this case we are setting the gaps to zero.

We already created a bleed so the cuts will
not intersect or be too close to each other
with zero gap between prints.

To print go to the File Menu and choose
Print or click the Print Icon on the shortcut
bar. The print dialog will appear. Make sure
Print+Cut is selected. Click the Properties
button to access the printer settings such
as Print Quality, Saturation and Color
Matching. For a full explanation of printer
driver settings see section 5F.

(3 PTCreate: Untitled 3

File Edit Object Path Effects Teat View Cutter Window

Set the gap between the rows and columns.

< jlﬂlﬁEH i

Transform
furange
Alignment
Distribute
Group
Ungroup
Break Apart
Menge

Chip Path
Clip Mask

Duplicate Rotated...

Hide
Show All

Lock
Unleck Al

Remove Effects

Ctrl+G
Ctrl s+ bbbt

Ctrl+B
Clel+Shall+B

Clel+Shilt+D

Clrl=Ad=L
Clrl+ AlL=Shilt=L
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4H Print Preview

Before you print you can click the Preview button to verify what objects will cut and what objects will print.
Check either Show Cut Lines or Show Printable to see what will print or cut.

1@ PTCrwate Pacc - [u] =

File i OBjecs Famth Loy ecti Tt View Culter Window Help

i MU|dN|D BN 2|73
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41 Vector File Specifications for Designer

When importing files using the methods described in section 4 <> please make sure the imported file
follows the specifications below:
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Section 5: Printing only to Pre Die-Cut labels

If you don't need to cut custom shapes, the LX610e is an extremely capable Pre Die-Cut Label printer. While
PTCreate can print only to the LX610e other dedicated printing programs offer some advantages.

5 A Adding highlights to a label with NiceLabel

Load a colour, clear or metallic ribbon. For instructions see Section 2 C.

1. Select”“New Label” Select the Printer “DTM LX610e” Click “Next".

Select the Printer
Select the privier that will be used to print e label, Vou £an slse set the label in prist on the: defsult prmster of the

Eamputer.

DML ® | Printer properties
Abways use the def gl printer
Desble-sided printing

Cancel g Finigh

2. Select”Print on a roll of labels”. Click “Next”".

Set the Page Sze
 you use a thermal printer, it is recommended 1o automatically set the page size. You can also choose to manually set the
page Lide. I o ez the exbet tack code of label e, you Can chode i fram the lne

® Prieg on & roll of Mabels

Primt on & sheet of paper

Lasd ettarngs fremn & predefmed slesk

Cancel + Back et & Fnssh
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3. Choose Orientation. Click “Next”.

Sebect the Label Layout
Croose between portrant or landscaps orientaticn printing of your label Some prmters suppert exira rotations. The preview
page thowy how the Libel will thew om the Loneen s how will it b pristed out.

Crigmiation
v [} 3
Parirait Larudisape
Ratated
Frescew
—
=
Frinter Layout
Cancel < Back Hets | Finish

4. Set the dimensions of your label and unit of measure. Click “Next”.

Specity the Label Dimensions
These dimensions wene sutomatically set based on your printer or stock selection. You can fine-tune these dimensions if
thary ciifier from the petunl printed Label
Uinit of measure: | = |
Labwel Dimsprgiong.
Width: IS0 mm |2 Height WHmm o
Margrr
(3 000 - Top: Guld ey =
Right aniemm 5 Eothem: oiimm 2
Labek Aciodd
Herizontal count: 1% Horzantsl gag: w5
Vertical omnt: 12 Vetal gap: Qmm 3
Precesang sader = at At R et
Cancel <Bsck | | Mets | | Finish
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5. Review the label setup summary. If it is correct, click “Finish”. Your blank label will be displayed.

Sumenary
¥ hanve quscetitully configred your Lkl Review the tettingd and prect the Firith Bution 19 create the label

Pranilir: DTMLXEL0:
Lkl dimsngion: 1005 enim x TET e

Paper dimdndgicns  10LS mm x 762 mm

Cancel % Black Finish

After you click “Finish”, you can always go back and change any of these “Label Properties” settings, by going
to the Menu Bar and select “Document Properties” or double click on the blank label.

Once you have created your label size you can start to design your label using tools from the tool box/
button bar. You will need to add text, rectangles, lines and/or graphics. This can be done using one of the
buttons on the button bar at the top left screen.

ET‘.] Sy Anal v10 v A & @ @/

Paste B I U%S ; = = -':" "t Prin L{jtom e
=" nink=
Chipboard Font n Action

Dl R e T
, Click the Text buttons to add text to your labels. Edit the text

on screen or double click to open up text settings to change
font, size and other settings.

Tt Texct Fich et

- .- O

Barcode Picture Rectangle

> {:}

Line Ellipse Trmadrss

' Click the Picture button to add graphic. Click anywhere
on the label. A pop-up window will open to browse to the
image/graphic and select it with “Open”

Click the Rectangle, Line and Ellipse button to add geometri-
cal shapes.

Click the Barcode button to add a bar code. Double click the
bar code to choose the bar code type.

Tip 1:  Double-click any object to open settings for that object.
Tip2:  Go to the Help tab to access the NiceLabel Manual and Tutorials
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5A.1 Printing from NicelLabel

1.
2
3.
4

5.

To print, click the Print button E] or go to the File Menu and select “Print”. The Print
Dialogue window will appear. Print

Select the “DTM LX610e”".

Set the number of copies.

Click “Printer Settings” to adjust darkness, speed, etc. These settings are explained in Section 4 D
Click “Print”.

Congratulations! You have successfully created and printed your first label. The rest of this section will

explain how to seal labels with clear film and the printer settings. Also, you can find more tips and hints by

simply clicking Help in the main menu

5B Using BarTender for Pre Die-Cut Printing

Primera recommends BarTender for printing only. A fully functional Free Edition can be downloaded from

the BarTender website.

https://www.bartendersoftware.com/free-edition-download/

When you open BarTender you will be given the choice to select an existing label or create a new one using

a wizard. Use the following instructions as a guide through the wizard setup process.
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1. Choose“Start a new BarTender document..”

BarTender

Welcome!

What would you like to do?

Start a new BarTender document. ..

ﬁ Open an existing BarTender document. ..

©

Open a recenty used BarTender document:

[ ] Don't show this dialog again
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2. Select“Blank Template”. Click “Next”.

u Mew Do ument Wirand

Slarling Puinl
Eelect the starting point for the new document,

You can start with a blank template, or a pre-designed template
standards.

from a library of several common

Startng Pont:
(®) Blank template
(_) Sclect template from library

3. Select”Color Label 610e”. Click “Next”.
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5 Hew Document Wizard

Prinler Seleclion
Speafy the pnnter to use vath this dooument.

Prinnler Proper lies... |

< Back [Next »| | Fish | | Camel |

4. Select“Specify Custom Settings”. Click “Next”.

“ Mew Document Wizard >

Stk Salection

A Stodk spedfies the size of the page, and the size, number, and
position of the items on the page. You may celect a predefined

Stk on specilly your oven cuslom setlings.

(®) Specity Custom Scttings
(C)Use a Predefined Stod

Category! v

bock Name:

< Back | hext > | |Fnsh| l:iru:nl|

5. Set the page size, width and height to match labels installed in the printer. Click “Next”. Important:
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6.

Measure the label stock if you are unsure about the size.

“ Mew Document Wizard

Page Size
Selec ] a page siee Al oienlation.

Pagesize: |User Defined Size ‘L’
Vidth: [300 in | Hebt |20 i
Civienlalion

Page Size: Jx 2in
Template Size: 1.25x0.2In

< Back |next > | |F|-uh||cn-nl|

Select your label shape. This is typically “Rounded Rectangle” for standard labels from Primera.

Click Next.

“ Mew Document Wizard

Printed Item Shape
Spetify Ihe sduape of youn ilems.

Page Sine: 3x 2in
Template Size: 1.25x0.2In
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7. Setall of the margins to zero. (You can adjusted the left margin and Top of Form in the Label
Alignment Section). Click Next.

“ Mew Document Wizard

Margins
Spetily lhe margies fiw The page.

o
bottom:
Lek: 0.0 in |
Right

Page Sine: 3x 2in
Template Size: L5x0.4In

8. Set Rows and Columns to 1 for a standard label. Click Next.

“ Mew Document Wizard

Rows and Columns

Speerify Ihe ruorber of rosaes amd colnmres of itenmes on each page of slick.

Page Sire: 3x 2in
Template Size: 3x 2N
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9. Set Template Size to be the same as the label size. Click Next.

“ Mew Decument Wizard

Template Sze
Speadify the size of your itam.

- Template Size
Width: 3.0 i
L] 5et Marnally
Height: L0 n

Page Size: 2x2in
Temydale Siee: 3x 2in

|« gack [rext »| | Fnsh | | cancel |

10. Check the “Picture” box to add a background photo or graphic to your label. Click “Next”. If you click
“Finish”, the remaining default wizard options will be set and no picture will be added.

u New Docurnent Wizard

Template Background
Select a pcture or color for your badeground.,

- Badkground Features
Oceler
Allows you 1o speafy a fil color to use for the backgreund.
EAmicture
Allows you to use a picture for the badkground,
[ remplate image
Allows you to dsplay & picture of what you want your
completed design to look ke behind the design area. Yiou can
then design on top of that picture, making it easier to position
aned size objects.

Page Sire: 3x2in
Template Size; 3x 2

| < Bock [Mext =] | Fish | | Concel
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11. Select“Embedded Picture”. Click the “File” Button to browse to the location of your photo/graphic

file. Set the Size Method to “Stretch”. Note the preview to the right. Click “Next” if you are satisfied

with the layout of the photo or graphic. Otherwise you may try one of the other Size Methods in
the drop down menu.

u Mew Docurment Wizard

Template Background Picture
Select a mecture for your template badeground.

Soumce: Embedded Picure v| e
Get Pichure From
_ Seanner of Camera...

Sze Method: [ Stretch

g

- Dobons -

Cpreprinted

Print When: | Always

Overhang Template: | 0.0 in

Pages Size: Ix2in
Image Pr Perrnanent]
ol - A Tempiate Size: 3X 2

| < Back  Mext » | | Finish Cancel

12. Review the label setup summary. If it is correct, click “Finish”. Your blank label or label with
background will be displayed.

u Mew Docurment Wizard

Fnichedr

when you press Finish, & new BarTender document vell be Preveen:
created using the settngs that you specfied.

Rt

‘Sharting Document: Dlank

Printer: Cokar Labsl 910

Page Sipe: 3xin

Template Sine: Ixdin

Background:

Embedded Pichure:  LipBaim_Ix2. PG

Fage Sze: 3x 1in
Template Sirez 3x 2in

|« Badk | et = Finish Cancel
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You can edit any of these initial settings by going to the File Menu and selecting “Page Setup”. Basic and

advanced settings are available on the various tabs.

Page Setup >
Hock Page Layout Shape Media Hemdlng  Fonbing Order  Templates  Background
Layout Previee:
Riwes! | 1 >E-‘ Cnkmmrs: | 1 |::|
- Margire:

Battom: 0.0 in | Right: 0.0 n

Hirle: Seme thve Page Lab o enable design in e margn ares,

- Template Sire
width: 1.0 n
[ 52t Marualy
Hexght: 20 in
Page Sizez x 2"
Templabe Sieez: 3" x 2"
Wieard,.. | Lo || cnad || teb |
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5C Add Text, Barcodes and Graphics to a BarTender Label

Once you have created your label size you will be able to add text, a barcode and/or graphics. This can be
done using one of the buttons on the button bar at the top of the screen.

Add Text. Click the Text button. Now Add Graphic. Click the Image button.
click anywhere on your label. Now click anywhere on your label. An
“Sample Text” will appear. Edit the Image icon will appear. Doubleclick
text on screen or double click it to it to open up image settings and
open up text settings to change font, browse to the image/graphic that you
size and other settings. would like to insert.

[ T T ST —

- ] x
File Edt View OCreste Aminge Adminster Tools  Window  Help
e8I L@ g iV 1M =g B QLGRS
ana e B I U S x, x2 i,f_{, — - A - Sup »EE—— -
Laet \ 8 % Documsntlbte Documenthbte x| T
Layer 1 |.|,|.-1|.|.|.|.'ﬂ|.|.|.|.\1|.|.|,||.11.|.|.|.1l,|.|.|."-|.|.I.|':|'.':
‘ - in and Refreshing 7

Shrawberty
oo g

Lip Balmy Ine R08:

/Haf Tes

TS el 157
Page Setup. Click the Page Setup Add Barcode. Click the Barcode
button to change your label size, button. Now click anywhere on your
adjust corner radius or change the label. A barcode settings window will
shape. appear. Here you can choose any type

of barcode and enter the value.

Tip! Double-click any object to open settings for that object.
Tip! Go to the Help menu to access the BarTender Manual and Tutorials.
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5D Printing from Other Programs

Since this printer uses a standard Windows printer driver you can print from any application you would like.
There are just a few things to remember that will make it much easier.

1. Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of the label
that you are using. When printing from any other program you must do this manually. Before you
print, simply set the custom page size just as you would set print quality in the printing

preferences. In the example below the label size is 4” x 3" so the custom page size is set to 400 x
4300 (displayed in .01 inch units).

| = Prinbng Preferences

Dplicnd

[iw Cotor Label 610 3ettings.
Al = Cuttom Pags Sise
P A
Prod Cualbly: Cluidly £
Color Matching: I Jloss Pager
Ink Saturation: 100

Selact Panter
B Celor Lab<l 610

Salus Fieady [IPestafie | Prefemnces Custbarm Fam Sise *

Le—r——ter
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2. Check the image or document size. The image size or document size set in lllustrator should match
to the Page/Label Size set in the driver. If you have set your page size to 4" x 4” but your image is
actually 5”x 3" the printer driver will automatically shrink your image to fit inside the 4” x 4" label.
The result is that the actual printed label is 4" x 2.4". Avoid this by setting your document size or
image size to match the label size.

3. Choose the right printing program. There are many different applications that are capable of
printing to the LX610e. However, there are only a few that are ideal printing applications. For
example, Adobe lllustrator is an excellent design program but is not always the best printing
program. It can be difficult to find the printing preferences or to know the exact size of the art
board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG and
print from BarTender.
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5E Creating a Full Bleed Print

To create a label that completely fills the space with no white margins, adjust these settings in the status
monitor and printing application (BarTender). This is only necessary if you are printing to Pre- Die Cut Label
stock. If you are printing and cutting using die cutting media, you can adjust the position of the cut line to
accomplish this.

Page Size. Increase the page size width by .03 inches (1mm). Increase the height by .03 inches (Tmm). If
you are using BarTender, simply change the size under the File Menu - Page Setup. If you are using other
graphics programs you will need to change the page size in the application and in the printer driver

Frint | Object Prind Method

preferences.

Primewe
=
51 Cpbone
o
P @ Color Label 610 Sethings
Lt m Custom  + | | Custom Page Size
o - Cricntation: Portrait

Print Quality: Quality &
Q Color [ Custorm Form Sire W

Imk Sat
0 Enable ;

Linits
Launch Visdth: 428 =
! Details ® 0.01 Inchea
)] 500 =
[ ! (101 Millimedem
Height: 435 2
[ 50 . 2200 ]
Cancel
Te
QK Cancel

Left Margin Offset. You must decrease the left margin offset to center the over bleed on the label. If you
over bleed by .03"you will need to decrease the Left Margin Offset by 0.4mm. This will center the page size
increase so there is a .03 inch over bleed on both left and right sides. Some additional adjustment may be
necessary if the label was not perfectly aligned to begin with. See Section 4E.
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TOF. Increase the Top of Form by 0.4mm. This will cause the printer to start printing before the label and
ensure a fully printed label. Some additional adjustment may be necessary if the label was not perfectly
aligned to begin with. See Section 4E.

7] Firninnn Fringivits - O =
LG
Color Label 610 - Idle
Cidar Labal B w
Qo | Prrialgnmens | Label Feed | Pricdw Seings
_—
-
.1.![%2 50%
g
o
L Maigen (]
o | $ E +,
Mg hange e
'] E.J +

Cirding Crly

Note: It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause
the printer to skip labels. This is because the printer stops printing too late to sense the next label.
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5F Printer Driver Settings

Once the printer driver has been successfully installed, you will need to setup the driver with the
appropriate print options. Refer to the following steps to change or verify your default printer driver
preferences. These settings will apply to all new designs created in BarTender or other programs after the
preferences were changed. Existing labels saved in BarTender will not be affected since the preferences
are saved with the label. To change these preferences, you will have to change printer preferences through
BarTender. (File Menu - Printer Settings)

Click the Start button, search for “Printers”. Select Printers and Scanners. Select the Color Label 610.

Choose Manage. Select Printing preferences.

B

@ Color Label 610

Manage your device

Printer status:  Offline

Open print queue
Sektings o x
Print a test page
& H  Runthe boubleshooler Printers & scanners

I Fi Printer properties

Fing |ﬂ] Color Label 610
Panting preferences h
Devics Hardware properties Open queus m Remave device

E§ H

I = Prnters & scanners

E%SI Color Label 610 Printing Preferences x

Options

g Color Label 610 Settings

............. Custom Page Size

------------- Crientation: Portrait

............. Print Quality: Quality 2

------------- Color Matching: Vivid Photos
------------- Ink Saturation: 83

------------- Enable Bi-di Printing: ¥es
------------- Launch PrintHub...

............. Details...
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Note on PC Settings:

Most applications allow you to change these same printer driver options from their “Print” and/or “Printer
Setup” screens. Some applications such as BarTender save your settings with the label, others use settings
only for the current print job just sent to the printer.

Paper Size

If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program
other than BarTender you will need to set this to the dimensions of your label. Keep in mind that the
dimensions are always relative to the width and height of the actual label in the printer. Orientation of an
image on the label should not change this setting. See Section 2A for minimum and maximum label sizes.

Orientation

There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to right

or as shown on the screen, select portrait. If you wish your printing to rotate 90 degrees from what you see
on the screen so it is printing horizontally, select landscape as your orientation. Remember, this does not
change the width and height Paper Size. It is only a tool for viewing a label upright on screen that will be
printed sideways on the printer.

Print Quality

There are 4 levels of print quality in the driver. The lower the quality, the faster the print. Quality 1 provides
the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment
with the different levels when designing your label to find a good balance between print quality and print
speed. Quality 2 is the default.

Color Matching

There are several options available depending on which cartridge is installed (Pigment or Dye). The options
will update automatically depending on which cartridge is installed.

Vivid Graphics mode is best used for graphical images where accurate color reproduction is not as

essential. Images printed in this mode will look more vibrant because more ink is being used to produce
them.However, printing images of people may produce skin tones that have a reddish tint.

Vivid Photos mode is best used for photographic images where accurate color reproduction is very
essential. Images printed in this mode will look lighter than those printed in Vivid Graphics mode. Skin
tones especially will look more natural in this mode.

ICC Gloss Paper, ICC Gloss Polyester and ICC Matte Bopp are all ICC calibrated color matching options.
Select the setting that corresponds to your installed Primera media of the same type to produce ICC color
matched prints. Note: ICC monitor calibration and additional setup is required for this option to work.

-NONE- will use no color matching.
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Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will
provide the most accurate color matching. If the ink is not drying fast enough or “bleeding’, you can
decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

Rotate 180 Degrees
Set this setting to Yes to print with the labels right side up as they exit the printer.
Enable Bi-di

Set to “Yes” for fastest print speed. Requires an alignment print after every cartridge change. Set to “No” for
better quality print (in some cases).

Launch PrintHub
This setting will open the Primera PrintHub application.
Details

Select this setting to see current firmware and driver version information and other printer settings.
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Section 6: Troubleshooting

6A Solving Pre Die-Cut Print Alignment Problems

Image is Vertically Offset (White space can be seen on the top or bottom of the label) The LX610e decides
where to start printing by detecting the start of a die-cut label, detecting a black mark on the back or
detecting a thru-hole that corresponds to the start of the label. The following items can cause the label
sensor to improperly detect the start of a label:

1. TOF Offset. TOF stands for Top of Form and this setting allows you to fine tune the alignment of your
printing on your label stock. This will be factory calibrated. If fine tuning is needed, increase this setting to
move the image down on the label; decrease this setting to move the image up on the label. The unit of
measure is 0.1mm.

2. Nonstandard / Non-translucent Backing Material. Test the unit with approved label stock from
Primera (ask tech support to send a sample). If it prints correctly, your label stock may not be compatible.
The label sensor needs to see the difference between a label and a backing material by seeing through the
label stock for light variations. If it cannot see through the label, problems will arise. If you must use this
type of backing, try label stock that has a black mark on the back to show where the label begins. You will
need to change the Sensor Type setting in the driver preferences to Reflective if you switch to a label with a
black mark on the back.

3. Improper Label Gap Distance. If the gap between labels is too small there will not be enough time for
the gap to be detected. See Label Specifications.

4. Page Size is Bigger than Label Stock Size. If the page size set in the driver is larger than the actual label
stock, ink will be printed on the gaps and the sensor will start looking for a gap too late. This can cause label
skipping or inconsistent print starting points.

5. Portrait / Landscape. If the Portrait / Landscape setting does not correspond to the label stock installed

this will also cause the printer to print over the gap and onto the next label. Make sure this is set correctly.

6. Sensor Position. Circular, nonstandard label shapes or multiple labels across will require precise
adjustment of the label sensor. If you are using circular or other non rectangular die-cut labels see Section
2B for instructions.

The image is printing horizontally offset
(White space is seen on the left or right side of the label)

Two printer driver settings can affect this issue. Left Margin Offset. This adjustment is found in the Status
Monitor. If you see white space on the right side of the label and overlap on the opposite side, increase the
number. If you see white space on the left side of the label and overlap on the opposite side decrease the
number (Negative numbers are allowed). Note: Usually a space on the right side indicates a margin around
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the label that is not being accounted for. The printer is factory calibrated for a 2mm margin. A larger margin

around the label will cause a right side space. Page Size. Often the page size is not large enough for the
label. If this is the case you may see white space on the right side of the label and no image overlap on the

opposite side. This indicates that the page size needs to be increased. Increase the page size through the
printer preferences enough to cover the label.
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6B Maintenance

Replacing the Cutter Wear Strip

The wear strip is the surface directly underneath the cutting blade in the cutter mechanism. Over time this
strip will wear down due to cutter knife pressure. It can also be damaged if the knife cuts through the liner
and contacts the wear strip.

To replace the wear strip remove any media from the cutter mechanism. Power off the Printer.

Push the knife carrier gently to the left. Grab one end of the wear strip and pull it off the cutter. If necessary,
use a utility knife to get under the strip to start it. The wear strip is held in place with adhesive so there may
be adhesive residue. Clean off the adhesive with isopropyl alcohol.

Remove the liner from the new wear strip. Press the strip into place. Make sure it is fully seated in the
recessed pocket.

Wear Strip Location

(Red Color is only
meant to highlight
location)

Replacement Wear Strip Part Number 074549 (10 pack)
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Label Cut Dust
Label cut dust can accumulate at any place along the cut path.

Paper media creates more dust than synthetic material. Dust build up does not cause any specific
immediate problems but it can eventually cause problems with the moving parts and electronics in the
cutter.

Periodically vacuum the cutter area and rollers.

Cleaning the Printer
The case of the printer can be cleaned with an ammonia based window cleaner and a lint-free cloth.

Over time, ink overspray may gather at the base of the printer. The printer is designed using a vacuum
system to gather most of this ink on a series of saturation pads. Eventually, these pads may need to be
replaced. Contact tech support to determine if pad replacement is necessary.
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6C Poor Print Quality — Cleaning the Cartridge

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect
a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out of the printer
more than 30 minutes, the ink in the print head nozzles may have dried. If you are having print quality
problems, follow the steps below:

1. Before moving on to the next step, ensure that the ink level of the color cartridge is more than
10%. If the ink level is lower than 10%, replace the cartridge.

2. Try cleaning the cartridge using the clean function in PrintHub.

7 Frarnienn Frintivits

LEE

Ciodar Label BIC W

B - r =
] |§- I Tear O Badian v’ ?
Chrilena Oy ' "-':. Ty
, f ‘

.
t’- Satlings

3. Determine if printing is now acceptable by printing your image. If the sample has missing colors or
voids within a color strip, remove the cartridge from the printer and proceed to step 4.
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4. Prepare items needed for procedure
Two Paper Towels A Glass of Water
folded four times each
5.
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6. Place one paper towel on cartridge nozzles. Gently press the paper towel with your finger.
Leave the paper towel on the nozzles for 30-40 seconds.

Cartridge Nozzles

Place one paper Gently press Leave paper
towel on nozzles paper towel with towel on nozzles
finger for 30-40 seconds

7. Wipe nozzles.
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a. Place second paper towel on flat/hard surface.
b.  Press the nozzles into the paper towel. \

¢.  Firmly tap the top of the cartridge three times to
force the ink out.

d. Wipe/Drag the cartridge in the direction indicated.

e.  Repeat until all colors are seen on the paper towel.

After wiping the nozzles, the paper towel should
show all three colors. If all three colors are present,

proceed to step 8. If the paper towel doesn’t show
all three colors, then repeat step 7. If paper towel

still doesn't show all three colors repeating step 7, l
then replace the cartridge.

8. Dry the cartridge.

Dry excess water from cartridge.
Ensure cartridge contacts are
completely dry. Printer damage
may result if cartridge contacts
are not completely dry.

9. Verify cartridge is now functioning properly by printing your label.
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6D Technical Support.

If you have difficulties operating your Printer, contact technical support using one of the methods listed
below.

Primera Knowledge Base www.primera.com/kb

Open the software. Click on the Help
BarTender Software Help files

Menu - Contents

Email Support support@primera.com
763-475-6669 (Mon - Fri 7 a.m. - 10 p.m CST
Phone Support
and Saturday 11 a.m. -8 p.m.)
http://primera.com - look for the chat
Chat

prompt on lower right

Technical DTM Print Support

Contact the DTM Print support team Mondays - Thursdays DTM
from 9:00 - 17:00 and Fridays from 9:00 - 15:00 using the
online live chat at the webpage dtm-print.eu, fill out the :ri.n?’.‘

online support from at support.dtm-print.eu or write us
anytime an email to support@dtm-print.eu.

This service is free for all our customers.
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Pre-die cut media: Up to 46mm per second (1.8")
PRINT SPEED

Digital die-cut speeds are dependent upon the image being cut
PRINT RESOLUTION Up to 4800 x 1200 dpi
PRINT TECHNOLOGY Thermal Inkjet
INKTYPES Dye-based CMY, Pigment CMY
LABELTYPES Pre-die cut, continuous and black marks
STANDARD CONNECTIVITY USB 2.0 (USB 3.0 compatible)

104mm (4.1") Digital Die Cut width is fixed at 4.1" However, smaller size
MAX PRINT WIDTH (DIE CUTTING)

labels can be cut from the 4.1" media.
MAX PRINT WIDTH (PRE-DIE CUT) 127mm (5”)
MAXIMUM PRINT LENGTH 305mm (12")
SUPPORTED OS Windows 7, 8 or 10.
DIMENSIONS 345mm W x 432mm D x 242mm H (13.6 W x 17" D x 9.5"H)
WEIGHT 12.5 Ibs (5.7kg)
POWER Input: 100 — 240 VAC, 50/60 Hz, 60 watts, Output: 12 volt 5 amp
WARRANTY One-year parts and labor; lifetime phone, chat and email support
OPERATING TEMPERATURE 5010 95°F (10 to 35°C)
RECOMMENDED OPERATING TEMPERATURE 61t087°F (16to32°C)
STORAGE TEMPERATURE -4t0 140° F (-20 to 60° C)
OPERATING HUMIDITY 10 to 60% RH (non-condensing)
STORAGE HUMIDITY 10 to 80% RH (non-condensing)
CERTIFICATIONS UL, UL-C, CE, FCC Class A

Primera Pigment 53495
REPLACEMENT INK CARTRIDGES

Primera Dye 53494

000000 00
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http://dtm-print.eu/en/specifications/lx610e.html

DTM Print GmbH

Mainzer Strasse 131

65187 Wiesbaden
Germany

Phone: +49 611927770
Email: sales@dtm-print.eu
http://dtm-print.eu
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